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1.0 System Overview

This document describes the preliminary structure of a computer modelling system
intended to help resource managers consider wildlife related objectives when planning and
conducting forest management operations. This document has several purposes:

to provide an initial description of the system and the manner in which it may
function and be operated;

to provide a preliminary basis upon which to refine system design;
to provide a guide for the initial development of the system; and

to crystallize the vision of the system so that subsequent development can proceed
in a clear and organized manner.

The system described here is based on the results of a workshop organized by the
Western Newfoundland Model Forest and held in Cornerbrook Newfoundland, March 1 - 3,

1994.

11 Terminology

A few key terms are defined below to clarify how they have been used in the document.

System

Model

Interface

Scenario

In the context of this document, the system refers to the entire wildlife modelling
system that is the subject of this report.

A model is any simplified representation of an object, process, or series of
processes. Although there are many types of models, including conceptual
models, physical models, and mathematical models, in this document the term is
used to refer to computer programs whose intent is to simulate the dynamics of
natural processes related to forestry and/or wildlife management. The wildlife
modelling system will include a number of models.

The interface of computer software, as referred to in this document, is that part of
the software that allows users to control the execution of the system - it’s what the
users see when they use a piece of software. The interface of the wildlife
modelling system will allow users to run models, examine output, design
scenarios, efc.

A scenario, as the term is used in this document, is any single execution of a

model or models with a unique set of conditions. For example, one scenario may
simulate the effects of a timber harvesting pattern on a wildlife species, another
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scenario may simulate the effects of a different harvesting pattern, and a third
scenario may simulate the effects of the original harvesting system, but may
simulate the effects on the wildlife species differently.

1.2 General Description

The system will be comprised of a linked series of models controlled by the user
through an interface. The emphasis in this document will be on describing the system’s
interface, rather than the design and specifics of the models. Two general types of models
will be components of the system: vegetation models that simulate changes in forest
vegetation over time as a function of forest management actions (e.g. levels of silviculture),
and wildlife models that use the output from the vegetation models to simulate to the
subsequent effects on wildlife habitat and populations. A simple representation of the system
is presented in Figure 1.1.

The system will have two distinct uses:

® as a planning tool, the system will be used by forest and wildlife managers to
design forest management strategies and plans to meet wildlife and forestry
objectives; and

* as a scientific tool, wildlife researchers and managers will use the system to
investigate hypotheses and relationships about the manner in which forest
management and vegetation change affect wildlife habitat and populations.

As noted above, this document is intended only to provide a preliminary description
of the wildlife modelling system. We expect and hope that it will be modified and refined in
the future as knowledge of wildlife-forestry relationships improve, user needs change, data
availability increases and modelling and software design techniques and features improve. At
present, the general state of knowledge about the manner in which forest management actions
affect wildlife is very imperfect. In Newfoundland, as elsewhere, much data remains to be
collected and even simple relationships are not well understood. One school of thought
suggests that models should only be used to make predictions once significant amounts of
data have been collected, and relationships are well understood. In this capacity, models
serve basically as integrators of data and relationships. This project, however, is based on
an alternate approach, known as Adaptive Environmental Assessment and Management
(AEAM) (Holling 1978; Walters 1986), that has the following premises:

e models should be used as a basis to improve our understanding of ecological
systems and test hypotheses about the manner in which systems function - this
implies that having "all the data" is not a necessary precursor to developing and
using models;
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Figure 1.1 Simple representation of the wildlife modelling system
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¢ models developed with imperfect or missing data can make valuable contributions
to planning, as they predict quantitative results - quantitative predictions provide a
solid basis upon which to improve, while qualitative estimates provide a much
poorer basis.

Following up on these points, it will be important for users to remember that model
predictions will be imprecise and often incorrect. Natural dynamics are far too complex and
poorly understood to be accurately mimicked by computer models of the sort that will
comprise the preliminary version of the wildlife modelling system. Model results should be
interpreted as forecasts, rather than reality. The system is intended to support decisions made
by human resource managers, and definitely not to replace managers’ abilities to make
decisions based on their professional judgement.

ESSA Technologies Ltd. 4
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2.0 Bounding the System

The most important choices in any modelling exercise include deciding upon the basic
level of concern and selecting the components to be explicitly considered in addressing this
level of concern. With the AEAM approach, these choices are initiated in what is known as a
"bounding exercise". The bounding exercise forces workshop participants to define a finite
and realistic set of model inputs and outputs, and to place them in an appropriate spatial and
temporal framework.

The following sections outline the decisions made by participants during the
workshop’s model bounding exercise. For the purposes of this exercise, the system to be
bounded included only the vegetation and wildlife models of the overall decision support
system (as shown in Figure 1.1). Components of the decision support system that involved
tasks such as database management, Geographic Information Systems (GIS) and user
interface were considered external to the bounding exercise.

2.1  Spatial Extent and Resolution

Any model of a physical system is necessarily confined within some spatial extent.
Workshop participants agreed that the system should be developed for use over the entire
Western Newfoundland Model Forest (approximately 900,000 ha). The system should be
designed so that it can be used to make predictions either over the entire Model Forest, or
alternatively for only certain portions of the Model Forest. For example, users may wish to
use the system for analysis within a particular management unit, watershed, or collection of
stands. While the initial focus will be to develop a system that can be used in the Model
Forest, where possible the system should be designed so that it can easily be adapted for use
in other parts of the province.

The spatial resolution of the system is defined as the smallest spatial unit over which
the decision support system will make explicit spatial predictions for the user. For this
system, participants agreed that this should be a stand (of which there are approximately
40,000 represented in the Model Forest).

2.2 Temporal Extent and Resolution

The temporal extent of the system is the time period over which the system should be
capable of making predictions. For the system to predict the full range of impacts that might
occur as a result of a management action, it should be capable of making predictions for at
least one complete overstory rotation. Participants felt that a temporal extent of
approximately 100-200 years would be appropriate.
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The temporal resolution of the model is defined as the smallest unit of time over
which the decision support system will be required to make predictions for the user.
Participants felt that changes in overstory vegetation, which in turn will drive much of the
system’s dynamics, can at best be predicted every S years. As a result, a 5-year step was
selected as an appropriate temporal resolution for the system.

2.3 Actions

Using AEAM terminology, "actions" are simply those activities that managers can
consider in their attempts to manipulate a system to meet goals and objectives. From the
standpoint of simulation models, they are quantities (e.g. silvicultural treatment) which have
some influence on the model, but which are not predicted by the model. Instead their levels
are specified outside of the model, usually as a part of an overall policy or management
strategy. Although management strategies are usually implemented as a suite of actions, it is
important that the system be capable of varying and responding to actions individually, to
gain a sense of the system’s sensitivity to particular decisions.

The following actions were identified by workshop participants to be included in the
preliminary version of the decision support system:

1. Target level of harvesting. Expressed as the volume of wood harvested (in m®) for
the entire Model Forest, for each 5-year time step.

2. Target harvesting pattern. Set the minimum and maximum block size for
harvesting, for each 5-year time step.

3. Area damaged by fire and insects. Identify stands damaged for each 5-year time
step.

4. Silvicultural treatment (thinning, planting and herbicides). Identify treatment type
for each stand, for each 5-year time step.

5. Width of riparian zone. Set the width around streams in which harvesting will not
occur (by stream type), for each 5-year time step.

A number of additional actions were identified by participants for future versions of
the decision support system.

6. Levels of hunting, snaring and angling. Expressed as the number of animals
harvested in the Model Forest (or possibly by management unit), for each 5-year
time step.

7. Target forest age class distribution. User should be able to set a target age class
distribution for the forest at any time in the future.

ESSA Technologies Ltd. 6
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8. Level of human intervention (e.g. number of visitor days).
9. Level of habitat enhancement.

10. Changes in climate.

2.4 Indicators

Indicators are those quantities which allow the user to observe and evaluate the
performance of the system in response to changes in management actions. As different users
will rely upon different measures to evaluate system performance, it is important to include a
diverse and comprehensive set of indicators that truly represent the interests of all
participants and agencies.

The list of indicators is divided into those that are the responsibility of the vegetation
component of the decision support system, and those that are the responsibility of the wildlife
component. Note that many of the vegetation indicators are also required as inputs to the
wildlife models. Participants agreed, however, that for the first version of the system, the
effects of wildlife on vegetation (e.g. through browsing) would not be included. These effects
could be accounted for, however, in future versions of the system.

Vegetation Indicators

Participants agreed that the following indicators of vegetation should be predicted by
the decision support system for each time step (i.e. 5-year period) and spatial unit (i.e. stand)
of a model run:

1. Volume of harvest. Expressed as the volume of wood harvested (in m?).

2. Volume of overstory growing stock. Expressed as the volume of wood standing (in
m?) for the stand.

3. Overstory crown density. Expressed as the average crown density of the stand.
4. Overstory age. Expressed as the 5-year age class of the stand.
5. Overstory height. Expressed as average height of the stand (in metres).

6. Overstory species composition. Expressed as the species working group of the
stand (e.g. balsam fir, black spruce, hardwood/softwood).

7. Understory species composition.
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8. Understory percent ground cover.
9. Volume of coarse woody debris.

An additional vegetation indicator was identified by participants for future versions of
the decision support system:

10.  Density of snags. The number of snags per hectare.

Wildlife Indicators

The following indicators were identified for the wildlife module. These would be
predicted for each time step (i.e. 5-year period) and spatial unit (i.e. stand) of a model run:

11.  Habitat suitability indices . Calculated for different species, including the
following: marten, moose, raptors, caribou, bears, fish, furbearers, hares,
grouse, waterfowl, songbirds, cavity nesters, and bats.

Additional wildlife indicators identified by participants for future versions of the
decision support system include:

12. Population densities. Densities (in number per hectare), by age class, for
different species.

13.  Measure of biodiversity.

14.  Measures of water quantity and quality.

ESSA Technologies Ltd. 8
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3.0 Vegetation Models

Having bounded the overall decision support system, participants at the workshop
then focussed upon defining the specific models and information required to predict the
vegetation indicators (as outlined in section 2.4). In order to predict the vegetation indicators
associated with the preliminary decision support system, it was agreed that two separate
models would be required:

* a spatial wood supply model for predicting the growth of the overstory; and

* a succession model, based upon Dammen’s FEC system, for predicting the
dynamics of the understory.

Table 3.1:  Vegetation indicators of the preliminary decision support system. Whether or
not it is currently possible to predict each indicator for the Model Forest is

also shown.

Vegetation | Indicator Currently

Model Possible?

Overstory | Volume of harvest Yes
Volume of overstory growing stock Yes
Overstory age Yes
Overstory species composition Yes
Overstory crown density No
Overstory height No

Understory | Understory species composition No
Understory percent ground cover No
Volume of coarse woody debris No

3.1 Overstory Model

A number of the vegetation indicators are associated with the overstory of the forest
(see Table 3.1); foresters currently use wood supply models to predict many of these

9 ESSA Technologies Ltd.
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indicators. A wood supply model is simply a bookkeeping device that tracks changes in the
overstory over time in response to user specified harvesting and silvicultural activities. Such
models generally require three basic inputs:

e the current state of the forest (i.e. a forest inventory);
e rules for how the forest inventory will change over time (i.e. yield curves);

¢ a management strategy - a prediction of the nature, timing and extent of
management actions, such as harvesting and silviculture, that will be implemented
over time.

Participants agreed that a spatial wood supply model, in which the fate of each stand
is predicted over time, would serve as the cornerstone for the vegetation modelling in the
preliminary decision support system. A spatial wood supply model (as opposed to non-
spatial) was chosen for the following reasons:

¢ the spatial arrangement of vegetation is a key determinant of the value of habitat
to many wildlife species;

¢ the technology exists to make spatial predictions of changes in vegetation (e.g.
GIS-FORMAN and HSG); and

* the forestry branch is moving to spatial modelling and it makes sense to be as
integrated with their approaches and practices as possible.

A number of spatial wood supply models have already been developed and are
currently being used in various locations across Canada and North America. A decision
support system working group is currently evaluating a number of these models, and is
planning to recommend a single model for use in all Model Forests. The choice of model has
been narrowed down to either GIS-FORMAN or HSG. It is anticipated that whichever of
these two models is recommended by the working group will be adopted for use in this
decision support system.

Without any significant modifications, current wood supply models will predict some,
but not all, of the overstory indicators (see Table 3.1). Those indicators which can currently
be predicted for the Model Forest, using a model such as GIS-FORMAN and existing data,
include the following:

volume of harvest;

volume of overstory growing stock;
overstory age; and

overstory species composition.

The remaining two overstory indicators, height and crown density, will require some
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additional analysis before predictions can be made within the decision support system:

® OQpverstory height. As a wood supply model is currently capable of predicting the
age of a stand over time, participants suggested that the height of a stand could
also be predicted if a relationship between the overstory age and height were
developed. Such a relationship would likely be developed for every volume yield
curve in the wood supply model. Participants suggested that the same data that
was used to generate the current volume yield curves for the Model Forest could
in turn be used to develop these age-height relationships.

® OQOverstory crown density. Changes in crown density over time could also be
predicted in similar way to overstory height. Participants suggested that crown
density could be predicted if a relationship between crown density and age were
developed for every volume yield curve in the wood supply model. It was further
suggested, however, that the data required to develop this relationship may not be
as readily available as the height data for the Model Forest.

3.2 Understory Model

While there are several existing models capable of predicting changes in the overstory
over time, there are no models currently capable of predicting the dynamics of the understory
for the Model Forest. Participants agreed that, in order to predict the understory indicators
outlined in Table 3.1, it would be necessary to develop some form of forest successional
model.

The basis for such a successional model would likely be Dammen’s FEC system for
Newfoundland. The successional model would track and predict the state of the FEC for each
stand over time as function of natural succession and disturbance (such as harvesting). Using
the predicted FEC for a stand in the future, and simple relationships between FEC and each
of the understory indicators, the model would then predict the various understory indicators.

At present there are a number tasks that will need to be undertaken in order to
develop a version of such a successional model suitable for use within the Model Forest.

° Develop temporal rules for succession. While general rules exist for predicting
changes in FEC after various forms of disturbance, there are no rules for
predicting the timing of these successional changes. A group at Memorial
University, under the direction of Dr. Simms, is currently working to develop
these temporal rules of succession; a preliminary version of the rules is scheduled
for completion in the summer of 1994,

e Develop computer model. Once the temporal rules for FEC succession have been
developed, along with the relationships between each of the understory indicators
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and the site type, the next step will be to develop a computer model that uses
these rules to track and predict the FEC state for each stand over time. This
computer model will need to be designed so that it runs in parallel with the
decision support system’s wood supply model; this will allow the two models to
respond to the same management strategies over time.

® Dammen FEC inventory. As a starting point for its predictions, the successional
model will require an inventory of the present Dammen FEC for each stand in the
Model Forest. An initiative is currently underway, under the direction of George
Kitchen, to derive such an inventory for the Model Forest from the Canada Land
Inventory (CLI) forestry maps; a preliminary version of this inventory is
scheduled for completion in the summer of 1994.

©  Understory indicator relationships. In order to predict each of the understory
indicators listed in Table 3.1, relationships between the Dammen FEC and the
understory indicators will need to be developed. While the relationship between
the FEC and both the understory species composition and the percent ground
cover should not be too difficult to infer, predicting the volume of coarse woody
debris as a function of FEC will be much more challenging.

ESSA Technologies Ltd. 12
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4.0 Wildlife Models

The preliminary version of the system will be designed to simulate effects of various
management actions on individual species of wildlife. While recent definitions of wildlife
have been broadened to include all living organisms, workshop participants agreed that the
preliminary version of the system would focus upon terrestrial vertebrates. This assumption
reflects the bias of those involved in the design of the preliminary version, and is a practical

 starting point in the development of a more complete system.

For the purposes of the Western Newfoundland Model Forest, the most significant
drawback of limiting the scope of the system to terrestrial vertebrates is that effects on fish
and aquatic habitat are explicitly excluded from the preliminary version of the system.
Although fish are a critical aspect of the ecology of the Model Forest, workshop participants
agreed not to include the effects on fish and aquatic habitat in order to simplify the initial
system development. The explicit assumption here is that aquatic modelling work will
continue in parallel to the development of this system, with an eye towards eventually
merging the modelling efforts if and when it is appropriate.

4.1 Habitat Suitability Indices

For most terrestrial vertebrates, the principle effect of forest management operations
is due to changes in habitat. For this reason, a decision was made to focus the design of the
preliminary version of the system on predicting changes in wildlife habitat. A Habitat
Suitability Index (HSI) is a relatively simple means of measuring changes in habitat of a
wildlife species. An HSI mathematically combines estimates of the availability of certain
critical habitat features to produce a numerical index (generally between 0 and 1) of the
quality of the habitat in a stand or group of stands for a wildlife species. HSI’s have been
developed for many species across North America, and the technique, although simple, has
proven to be a robust and useful approach for estimating the quality of wildlife habitat.

A simple and preliminary HSI has been developed for boreal owls for Newfoundland
(Brazil and Knox 1994). In this HSI, stand measures of proximity to bogs (PB), age (AGE),
height class (HGT), species composition (SPC), and crown density (CD) are assigned
numerical ratings from 0 - 3 based upon their suitability for use by owls.

The first step in the calculation of this HSI is combining the values for HGT and CD
to generate a composite habitat quality measure (HC) as follows:

HC = HGT + CD
2

This implies that, for boreal owls, height class and crown density contribute equally to a

13 ESSA Technologies Ltd.
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composite quality of habitat that is, in turn, of equal value to the other attributes.
Independently, however, HGT and CD are of lesser value than the other attributes.

The suggested HSI formula is:

HSI = (PB * AGE * SPC * HC)*¥
3

The calculated value is applied only to similar stands 12 ha in size and with a
minimum diameter of 200 m. Smaller stands, or groups of stands, are not considered to be
useful habitat.

HSI’s for other species will obviously combine different stand/habitat variables in
different mathematical formulae. Few HSI's have been developed for species in
Newfoundland, but because of the robustness and utility of the approach, workshop
participants felt that it will likely be a key technique in managing habitat and estimating
potential effects of timber management on habitat in the Model Forest.

From this discussion and the example above, they key point that is relevant for the
design of the wildlife modelling system is that users will need to have a great deal of
flexibility in i) selecting which stand/habitat attributes to combine in an HSI; and ii) in
specifying the mathematical equations with which to combine the attributes.

4.2 Population Modelling
Generic Population Model

Wildlife managers are concerned about managing habitat and effects on habitat only
because habitat quality influences wildlife populations. In some instances the ultimate
determinant of a wildlife population is not habitat, but some other influence (e.g. hunting).
Therefore, knowing the quality of habitat is necessary, but not sufficient information upon
which to base wildlife management decisions.

For this reason population models should be included in a comprehensive wildlife
modelling system. It would likely be possible to design generic population models that would
i) estimate a habitat-based carrying capacity based upon an HSI; and 1i) estimate a "true"
population by simulating non-habitat related effects on the habitat-based carrying capacity.
These effects would include hunting, trapping, predation, disease, etc. Each of these effects
may occur by density-dependent or density-independent means. Such 2 model would be
considerably more complex than the HSI model described above. Depending upon the
immediate needs/interests of the Model Forest biologists, it may or may not be appropriate to
include such a model in the preliminary version of the wildlife modelling system.

Considerable effort would need to be devoted to designing such a model. Obviously
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the model design would need to be complete before an interface could be designed. For this
reason, the interface for such a model is not included in this document. Should the decision
be made to include such a model in the preliminary version, the model design would need to
be completed before the interface could be developed and included in a document such as
this.

Detailed Population Models

Many wildlife computer models are highly-refined and species specific. Although
none exist at present that are applicable to the Model Forest, development efforts are
underway (e.g. marten persistence model). These models usually have species-specific
algorithms, functions, logic, and utility. Although models such as these are less flexible
than those described above, their detail and depth can make them powerful management and
research tools. In future versions of a wildlife modelling system, it may be appropriate and
useful to mtegrate such detailed models into the system.

15 ESSA Technologies Ltd.
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5.0 Preliminary System Design

The following section provides a preliminary design for the wildlife modelling
system. The design presented here is intended only as a starting point for future users to
comment on before it is built, and to serve as a guide for future software development.

The system could be developed to run in either a Microsoft Windows or a Unix
workstation environment (e.g. as an ARC/INFO AML application); the final decision on the
hardware and software to be used will depend upon the availability of software development
tools at the time the actual programming for the system is initiated. Regardless of which
environment is selected, running the wildlife modelling system will require access to a Unix
workstation in order to process and store all of the information associated with the vegetation
model runs. Software currently exists that allows a PC-based computer, running Microsoft
Windows, to be linked to a Unix workstation through a local or wide area network (e.g.
across the entire province). While they will not necessarily require a workstation of their
own, users of the wildlife modelling system will at least require access to a workstation.

User Interface

Users would access all of the functions of the wildlife modelling system through the
main menu. Each of the menus is described in detail below.

Wildlife Modelling System
ndow Help

File Model Run Display Wi

The File menu is used for file management. The options under the Model menu let
users set habitat indicators, modify the population model, or select a particular species
model. The Run menu allows user to specify a scenario and run the model. The results of
the run can be viewed, saved, and printed by using the options found under the Display
window. Users can compare two or more different displays using the options found under the
Window menu. Finally, a help system is accessible by selecting the options in the Help
menu. -

File Menu  The File menu houses all of the file management options.

Lead...
Save
Save As...
Delete...

¥Yegetation Library...
Spatial Extents...

Exit

Load  Selecting Load under the File menu allows users to load pre-created
setting files. Each file contains a complete record of the settings for

17 ESSA Technologies Ltd.
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Save, Save As,
Delete

Vegetation
Library

ESSA Technologies

every other menu choice in the system, and is created whenever the
user selects Save or Save As from the File menu.

¢ File'Load

Date Setting File Titla ad

94/03731:: Wildiife Branch's cusient models R R
84/01/14 Models uzed in 1335 annual plan [READ ONLYI

93212120 Gros Moine National Park t ibou habitat mode!
93712720 Fosestiy Canada testing of the -attan habRat model

93/068/15 Defauk Settings [READ-DNLY]

Sodt By
@ Date
‘O Tite
I~ Setling File Datads
Filename: CURRENT.SET
Author: Jane Doe, Nowfoundland Wiidife B
Description:

This setting fife tainz the best sstimates for the p
of the moose, maiten and boseal owi habitat modeis.

L+

+]

When a user selects a file to load, all of the system’s settings that are
associated with that file will be retrieved. This includes all of the
habitat models and their parameter values. Information about the file
name, author(s) of the file, and a detailed description of the file are
provided in the bottom half of the screen to provide useful
supplementary knowledge about particular files. For example, a setting
file might well contain all of the HSI models for a particular planning
exercise several months earlier. By loading this setting file in the
future, any user could see all of the models (and parameter values) used
earlier, and can be sure of reproducing the same predictions as any
other user using this same setting file.

These menu choices under the File menu allow users to perform
standard file management practices with setting files. Pressing Save will
save the current values for the settings of all menu choices (including
all models and parameters). Files that are particularly significant, such
as the default settings or the settings used to create annual plans, can be
saved in "read-only" format to prevent users from altering or modifying
them. Save As allows users to make a copy of a file under a new name.
Unwanted setting files can be removed by using the Delete function.

This choice under the File menu acts as a library or database of the
results from running the vegetation model. The vegetation model will
simulate changes in the forest vegetation over time as a result of forest
management activities, and will not be run directly from within the
wildlife modelling system. Instead, a library of output for various runs
of the vegetation model will be accessible from this option, where each
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run will consist of output from a spatial wood supply model such as
HSG or GIS-FORMAN.

. Vegetation Library

Date Vegetation Run Title I oK l
94/03/31 No harvesting
94703731 No silviculture
94703/31:: Cunent silviculture & harvesting
94/03/31 Maximum silviculture Delete
94/02/15 No silviculture & wide riparian
94/02715 Cunent silviculture & wide tiparian
94/02/15 Maximum silviculture & wide ripasian
94/01/25 Curirent harvesting & masten protection
94/01/25 Higher harvesting & marten protection

Sait By
Vegetation Run Details @ Date

O Title

Tile: [Cwirent silviculture & haivasting i

Date [yy/mm/dd):{94/03/31

Author:].lohn Doe, Newfoundiand Department of Forestsy E

Description:

This vegetation run was generatad to match the most recent wood +
supply analysis for the Model Forest. In this run, a number of j
assumptions were made about harvesting. regeneration and silviculture,
which include the following:

*]

Users can import results from the wood supply model by selecting
Import. Once the results have been imported, users can provide details
about the run (such as title, data, author(s), and a description) to help
distinguish between different vegetation model outputs. In the screen
above, for example, the run Current silviculture & harvesting has been
selected. Details about this run are provided in the bottom half of the
screen.

Users have the ability to edit the detailed descriptions of the vegetation
run by simply typing the new information into the appropriate text
boxes. Any unwanted runs can be deleted by pressing Delete.

This choice under the File menu will allow users to define a series of
spatial extents for use by the model. Users might be presented with a
map of the entire Model Forest, from which they can use a mouse to
define a particular area, ranging from a collection of stands to the
entire Model Forest. This area will then be named and saved as a new
spatial extent.

The wildlife models are manipulated through the options available
under the Model menu.
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t{_hitat Indicators...
Population Models...

Marten Model...

Habitat By selecting Habitat Indicators under the Model menu, users are able
Indicators  to define models for various habitat indicators.

B  HabitatIndicators

Habitat Indicators: [hear habitat
boreal owl habitat i o iiion
caribou habitat
marten habitat #1
marten habitat #2
moose habitat

" Habitat Indicator Details

Cancel

Title: [boreal owl habitat |

Date {yy/mm/dd): |94/03/01

Author: |Joe Brazil and Kathy Knox, Newfoundland Wildlife Division

Description: | Preliminary boreal ow! habitat suitability index for Newfoundland.
Note that this is not a working model, but just an exercise to
examine possible relationships,

Equation: | [{ProximityBog = AgeClass = SpeciesCompositien " ({HeightClass
+ Crown Density) 7 2]) == 0.25) /7 3

] * el I

Equation Generator

vt BT DODHH
HeightClass
SpeciesComposition E’ m E

ErownDensity

Users begin by selecting a particular habitat indicator. In the example
above, boreal owl habitat has been selected.

The central portion of this screen contains details about the selected
habitat indicator. Information is provided on the date the indicator was
created, its author(s), a description of the indicator, and an equation
that can be used to predict a Habitat Suitability Index (HSI) for a
particular species. Users can edit and modify the detailed information
on a particular habitat indicator by typing the new information into the
appropriate text boxes. New habitat indicators are easily added to the
system by naming a new indicator and selecting Add. Habitat indicators
that are no longer required can be removed by selecting Remove.

ESSA Technologies 20
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One of the most significant pieces of information about the habitat
indicator is the equation used to define the HSI. This equation uses
vegetation attributes, as predicted by the vegetation model (and stored
in the Vegetation Library), to produce a numerical index of the habitat
quality of an area for a particular species. By manipulating the equation
generator, users have extensive flexibility and power to create HSI
equations. Equations are created by clicking on operators and double-
clicking on variables listed on the bottom portion of the Habitat
Indicators screen.

To add, delete, or edit the available variables for a given habitat, press
the Edit Variables button at the bottom of the Habitat Indicators
screen. The screen below will appear.

Edit Variabies: 000
Vasiable Hame: JAgaClass | | Change l
Vogotation 1oveutoq,age m [ Add

Scoring System femove
Score: Attributs Range Cancsl I
0: <=40 Scote: |2

% 4160 e
3:>80

Each variable is linked to a single vegetation indicator. In the example
above, the variable AgeClass is associated with the vegetation attribute
overstory age. Users may wish to link a variable to a new attribute, or
create a new variable. By clicking on the scroll arrow to the right of
the text box, a drop-down list box of vegetation attributes appears, as is
shown below, from which users can select a vegetation attribute of their
choice.

ST Edit Vaniabless S ey
Yatiablo Nome: [AgeClass ] l Change l
Yegetation |overztory ago E I Add I
overslogy ge TR
Scoring System ] wau:w fcm denaity
Scoee: Attribute 74 3:::(:; specios compozition
voluowe of harvest

Qrowing Help

Once users have selected the variable and its attribute, they will need to
set scores for the ranges of a specific attribute. In the example above,
the scores for various ranges in overstory age are displayed. Stands
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Breakpoints

Population
Models

Marten Model

ESSA Technologies

with ages less than 40 years receive a score of 0 for the variable
AgeClass, stands with ages between 41 and 60 years receive a score of
1, stands between 61 and 80 years receive a score of 2, and stands with
ages greater than 80 years receive a score of 3. Older stands receive
higher scores than younger stands because boreal owls nest in tree
cavities, requiring that trees be of a certain diameter and age. Immature
stands (i.e. those younger than 40 years) provide minimal nesting
opportunities for boreal owls.

Any time a new vegetation attribute is selected, the scoring system will
automatically change to reflect appropriate ranges and scores for that
attribute. For example, if overstory height was selected as an attribute,
the scoring system will assign points to various ranges of tree heights.

Users may want to edit the scoring or rating system for a particular
attribute. This is done by pressing the Breakpoints button at the bottom
of the Edit Variables screen. For example, the following screen would
appear for the variable AgeClass that was described above:

Breakpainds 800
Breakpoints:
ég ] Remsove l

A breakpoint divides a range of data. To set a new breakpoint, simply
type in the new value and select Add. The system will automatically
adjust the scoring system. Existing breakpoints can also be removed by
selecting the breakpoint and clicking on the Remove button.

Although habitat greatly determines wildlife populations, other
influences such as hunting or disease are also important. The
Population Models choice under the Model menu will allow users to
estimate the effect of non-habitat related indicators on wildlife
populations. Note that, for the preliminary version of the system,
population models would not be included.

Detailed population models, such as a marten model, may be integrated
into the system as further menu choices in the future.
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The options under the Run menu allow users to run the model.
‘Run:

Start Run...
Abert Run

Users define a scenario and run the model by choosing the Start Run
choice under the Run menu.

e U Start Run' 5
Number of Years:
Spatial Extent: I Cancel I

{manageuenl unit 2 *

Vegetation Library Run:
[Ctment silviculture & harvesting

[1e]
EE

Output Indicators: [hear habital

marten habitat #1

marten habitat #2
moose habitat
overstory age '

overstory crown density.
overstory height
overstory species composition

volume of harvest: v

Before running the model, it is necessary to specify a set of parameters
that will define the scenario. Users can manipulate variables of time,
space, vegetation models and wildlife models. To begin, users must
specify the number of years for which the system should predict the
effects on wildlife. In the example above, the user has selected a
temporal extent of 150 years.

~Next, the user needs to select the spatial extent. By clicking on the

scroll arrow in this field, a drop-down list box of spatial extents is
displayed, as is shown in the screen below. A database of available
spatial extents would be maintained using the Spatial Extent choice
under the File menu as described earlier.
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Number of Years:
Spatial Extent: l Cancel! '

management unit 2

entire model forest
management unit 1
management anik 2R i

33

management unit 3
watershed 205
Go ome Natinal Park

boreal owl habitat:
catibou habitat
maiten habitat #11
marten habitat #2: -
moose habitat

volume of harvest::; i w

The model can make predictions over a range of spatial extents, from a
single stand to the entire Model Forest. In the example above, the user
has selected management unit 2 as the area under analysis.

Clicking on the scroll arrow in the Vegetation Library Run field will
also display a drop-down list box, from which users can select an
output run from the vegetation model to use with this scenario. In this
example, the user has selected to run the system using the vegetation
model run called Current silviculture & harvesting. A database of
available vegetation library runs would be maintained using the
Vegeration Library choice under the File menu (as described earlier).

Finally, users can indicate which output indicators they would like to
have the model calculate for this scenario.

Pressing Start will start the model run. Selecting the choice Abort Run
under the Run menu will terminate the model run.

The choices under the Display menu allow users to view the results of
the model run in mapped, graphical, or tabular form.

“Display:

Map...
Graph...
Table...

Classification Scheme...

Once a model run has been completed, users can view the results of the
run in mapped form. When Map is chosen under the Display menu, the
following screen appears:
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DisplayMap

jlndicatos: |manen habitat #1

Year:

Background Maps

management unit boundaries? u
park boundaries .
roads (primary)

roads [secondar

stieams:and lakes:ii:

watershed boundairies (pumar n

Destination
@ Screen
QO Printer
O File

Users begin by specifying which indicator they would like to view in
mapped form. By clicking the scroll button to the right of a text box, a
drop-down list of indicators will appear, as is shown in the screen
below.

it Display Map

Indicator: |marten habitat $#t1

I¢

boreal owi habitat

AT masten habitat #1:.6:
masten habitat #2
overstony age

Backgr overstory crown density
volume of harvest

Destination
® Scieen
QO Printet
O File

d age E 1z
park boundaries
soads [primary)
mads :econdax

wa!erzhed houndane: [primasy) hd

In the example above, the indicator marten habitat #1 has been
selected. Users must next specify the year for which they wish to view
the output of the model. Finally, users can select one or more
background maps. Users have the ability to set map colours and to
view the map on screen, save it to a file, or send it to a printer.

Results of the model run can be displayed in graphical format. As with
Display Map, users select the indicator they would like graphed. Two
types of graphs can be displayed: histogram or line graph. In the
example below, a histogram of boreal habitat for the year 100 is
displayed alongside a line graph displaying overstory age over the run
of the model from year O to year 200.
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[— B2 sEaWildlile Modelling Sy stemiis
Eile Model Hun Display Yindow Help

Boieal owl habital year 1005, 5507

Arsa
{sqkn)

pversiony age [+1~
2500
2000
0
Area 1500
trgem) 060
1000 0-80
500 8o
R : .
0 ) 109 150
Yex

Display Table  Results of the run can also be displayed in tabular format.

boreal owl habitat: i i

marten habitat #1 m
marten habitat #2 _

‘overstory age

‘overstory crown density

yolume of hasvest

Indicatoss:

Year:
Style ™3
® Summary i
O Detailed QO Printer

Users can choose between two types of tables. The first is a summary
report. The summary report will display the indicators as they change
over five-year intervals. Users can also to choose to view the model
output in a detailed report. Unlike the summary report, which looks at
how the indicators change over time, the detailed report offers a
snapshot examination of one specific year.The detailed report displays
indicators as they change from stand to stand for one particular time
step.

Classification  The Classification Scheme option allows users to modify how the
Scheme  results are displayed.

ESSA Technologies 26



Wwildlife Modelling System
Design Document

/Classitication Scheme

indicator:
boteal owl habitat: iy
marten habitat #1 ]
marten habitat §2 l

averstory age
overstaty crown density
volume of harvest

Display Classification

Clazz: Indicator Range Class:

good: 0.80.3 _
excefient: > 0.9 Breakpoints...

For each indicator, users are shown the range of values for the last
model run. For example, for boreal owl habitat, the range might be
from O to 1. For an indicator like overstory age, the range displayed
might be from O years to greater than 200 years. For display purposes,
values within each indicator’s range need to be assigned a class or
score, as is shown in the bottom half of the Classification Scheme
screen.

In the example above, ranges of values for the boreal owl habitat
indicator have been assigned a classification ranging from poor to
excellent. Users can easily modify these breakpoints by selecting

Breakpoints. The following screen will appear.

SR Biieakpoints i

Breakpoints:
XN Add_]

To add a new breakpoint, users enter the breakpoint into the text box
and select Add. When they return to the Classification Scheme screen
they will need to assign a class to this breakpoint, such as very good.

Note that these breakpoints differ from those described earlier for HSI
models, and are used only for display purposes in maps, graphs, and
tables. The values that are set in the Classification Scheme screen for
each indicator will be applied to all of the display formats. This helps
to maintain consistency and uniformity in the displayed results,
regardless of whether they are displayed in graph, tabular, or mapped
form.
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The options under the Window menu allow users to view the results of
multiple runs side by side.

| Window
i New Window
f Cascade

i Tile

These options will allow users to customize how the display windows
of the model output appear on their screen. For example, a user may
wish to run the model using two different vegetation runs: one at
current levels of silviculture and harvesting, and a second at maximum
silviculture levels, in order to trace the effect this will have on boreal
ow] habitat. Using the functions in the Window menu, users can open
several windows within which to view the results of several indicators
for each of the two runs.

Pressing Cascade will cause the display windows to overlap, leaving
the title bars visible. Pressing Tile will resize the display windows and

arrange them one on top of the other so that the entire contents of each
window are still visible.

An on-line help facility for the system will be available.
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ESSA Technologies Ltd. '
Suite 308, 9555 Yonge Street Phone: (905) 508-0860
Richmond Hill, Ontario, Canada L4C 9MS Fax: (905) 508-0863

March 29, 19%4

Mr. Darren Fillier

Wildlife Habitat Biologist

Western Newfoundland Model Forest Inc.
89 West Valley Rd.

Corner Brook, NF

A2H 2X4

Dear Darren:

Please find enclosed a bound and unbound copy of the report entitled Design Document
Jor a Wildlife Modelling System. In writing this report we have tried not only to capture the
results and consensus of the workshop, but also to provide an initial description of how the
system might actually look to the user. This preliminary design is not intended to be a definitive
view of how the system will eventually look; rather, we expect and hope that it will act as a
starting point for further discussion, and that it will be modified and refined in the future.

While we are confident that the design document will provide .
understanding of how the system will eventually work there is .onl
functionality that can be captured in a report. You will" ind tha; the design document inclu
a number of mock-ups of menu choices and screen. ';7 In order to produce these mock-u
we have actually created a prototype version ‘of the system’s software interface (which currently
runs under Microsoft Windows). Our past experience has shown us that demonstrating the actual
prototypé software product m—person can often provide much more insight than just a report.

With this in mmd ‘we suggest the following course of action as a follow-up to this project
for fmahzmg the system design:

@) _.-El:"f.'ClrcuIate the preliminary design document to all of the workshop participants and
. solicit their feedback.

(iiy  Arrange a 1-day meeting with a small group of representatives from the Model
Forest, Newfoundland Wildlife Division, Newfoundland Forest Service and ESSA
(similar to scoping meeting for this project?). Colin Daniel, who developed the
interface software, and myself (if budget permits) would attend the meeting from

IS




ESSA. At this meeting we would:

° demonstrate and fully explain the actual prototype software;

° answer specific questions about the system design;

° review feedback from those who reviewed the design document but were
unable to attend the meeting; and

° discuss potential modifications to the preliminary system design.

(iif)  Update the design document to reflect any changes to the preliminary design
agreed upon at the meeting.

We feel that this plan of attack would provide you with an effective means of further
enhancing the design of the wildlife modelling system, and ensuring that a broad consensus
regarding the system’s functionality is maintained. Demonstrating the software in-person should
provide potential users with a better understanding of the proposed system design, leading to a
more focussed discussion of the modifications and refinements that might be required. ESSA’s
involvement in this work would be in addition to that of the current project. We estimate that
the cost for ESSA’s involvement in these steps would be approximately $5,000-$7,000
(depending upon whether one or two of us attend the meeting).

Both Colin and I are excited about many of the ideas that surfaced at the workshop and
in the subsequent design document. We believe that the decision support initiative you are
embarking upon here is state-of-the-art for forest resource management, and look forward to
working with you further in the near future to turn these ideas into reality. If you have any
questions about the design document, or would like to discuss any of the ideas for future work
outlined above, please give Colin or me a call. I look forward to hearing from you again in the
near future. '

Sincerely,

AS @(é’ =S

Chris Wedeles _
p—— /l
c.c. Colin*Daniel, ESSA
Joe Brazil, Wildlife Division
Ken Curnew, Wildlife Division
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Forest, Wildlife, and Freshwater Resources Research Initiatives
in Insular Newfoundland
Comer Brook, Newfoundland, June 21-22, 1994

The Model Forest Coordinator of the Canadian Forest Service, Newfoundland and Labrador
Region, invites you to attend a workshop on "Forest, Wildlife, and Freshwater Resources
Research Initiatives in Insular Newfoundland” on June 21-22, 1994 in Corner Brook. This is
open to anyone who is conducting, or has recently conducted, research in Newfoundland related
to forestry, wildlife, or freshwater resources.

The purpose of this workshop is to provide an overview of the research being carried out in
insular Newfoundland relating to forest, wildlife and freshwater resources. This workshop will
provide the opportunity for a sharing of knowledge between researchers and managers.

Topic areas include, but are not limited to:

Wildiife Salmonid/W ater Quality
» mammals (large and small) « fish habitat and populations
* avifauna » water quality/quantity
» biediversity
Other
Forest Siie Classification (FEC) » soil arthropods and forest insects
» Remote sensing * nutrient balancing
» Successional modelling « computer modelling

If you would like to present your work at this workshop or attend as an observer, please inform
Brian Bonneil by April 29, 1924, I have attempted to distribute this to all persons with a
potential interest in this area. However, in the event that I have overlooked somecne, please
circulate this notice amongst vour colleagues.

Brian Bonnell

Model Forest Coordinator

Canadian Forest Service - Newfoundland and Labrador Region
89 West Valley Road

Corner Brook, Newfoundiand

AZH 2X4

Phone:  (709) 637-4300
Fax: (709) 634-0255
c-mail:  bbonnell@vax!.nefc.forestry.ca




Notes Regarding
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Corner Brook, NF

March 1 - 3, 1994

Brian Bonnell
CFS
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SPECIAL NOTE: This document was produced utilizing the notes taken by the authors during the March 1-3, 1994
workshop. It was written up independently from the ESSA document. It should also be noted that the authors' notes
were also given to ESSA for their review.

1.0 Introduction

No wildlife modelling, with respect to the development of decision support systems (DSS), has been carried out in
Newfoundland. The need for such modelling systems to aid managers in their pursuit of a more wholistic
management framework and process has been identified by the Western Newfoundland Model Forest (WNMF),
Consequently, individual research projects have been initiated within the WNMF for a variety of identified indicator
species to provide the information necessary to develop such wildlife models. The individual species' population
and habitat models are to be incorporated into a larger wildlife modelling system which, in turn, is a component
of an overall DSS for the WNMF. This DSS is to be utilized to aid managers in the integrated resource
management (IRM) process currently under development by the WNMF Management Group.

The WNMF Management Group has set as one of its objectives, the production of a comprehensive integrated
resource management plan by March 31, 1997. Consequently, a DSS tool, if to be utilized in the development of
that IRM plan, has to be functional at least a year previous to this.

The Wildlife Modelling System Design Workshop was initiated in order to begin the process of designing and
developing the wildlife modelling component of the DSS. Further background to the workshop is contained in the
17 February 1994 letter of invitation.

The objective of the workshop was "To begin the process of system design for a wildlife modelling system for the
Western Newfoundland Model Forest".

Figure 1 provides a schematic overview of the process to be followed in the development of the wildlife modelling
system (WMS).

1dentification of Need

Workshop is at

' )
‘( System Overview Design
the Design Stage

Medel Design
Interfacf Design J

Testing /
Refinement

—— Maodel Development / Programming

Interface Development

At this stage in the development of the WMS, the focus has been on the design level and not on actual programming
of models. This workshop was to provide the input for a system design document which would define a conceptual
view of the WMS as outlined by the various researchers and managers who participated. The system design
document developed by ESSA provides a WMS framework which may require further refinement and modification
to meet the requirements of the wildlife modelling system component of the DSS. Once consensus regarding the
system design has been reached, the next step in WMS development can proceed. The next step is actual model
development (i.e. programming) and subsequent testing and refinement (Figure 1).

The workshop consisted of several exercises to aid the participants in identifying their view of a WMS. The first
exercise consisted of defining the boundaries of the system (e.g. issues, actions, indicators, space, time). After this
initial phase, subgroup discussions were held on the vegetative and wildlife components that were to comprise an
overall WMS. The needs and requirements of a user interface and outputs of the WMS were discussed. The

1



workshop ended on a discussion of the work priorities to be undertaken in order to construct the wildlife medelling
system.

2.0 Bounding the System

The intent of the bounding exercise facilitated by ESSA, was to define the limits within which the system was to
be designed. These limits centred around the issues to be examined, the actions to be simulated, the indicators to
be predicted, and the space and temporal aspects within which the modelling system will operate.

2.1 Issues

The issues component of the bounding exercise was to allow the participants an opportunity to identify their major
concerns with system development. These issues aid in the identification of an overall system design at a very
generic level (e.g. flexibility, scope of project, generic needs assessment). This discussion resulted in a long list
of outstanding issues related to DSS development for the Western Newfoundland Model Forest.

* Timber Allocation: Two paper companies control most of the land. Do we make the assumption that they can cut
'x" amount of wood annually? Will or should the amount be a constant?

* Quantification of Habitat: How do we quantify habitat for various species?

* Linkage / integration of individual models (input/outputs, language, design)

* Integration of species models

* Address spatial constraints: Landscape level modelling

* Standardization: A need for standards for database design/development and model design/development(establish
set of ground rules for all modellers); (everyone to know what dealing with, where to head; equipment, users,
database,...)

* Interactions between and amongst species and habitat (i.e. one species may impact on another, etc.)

* Objective versus constraint type management (i.e. objective type mgmt: set goals/objectives for a wide variety of
factors and try and achieve them - very difficult)

* Data Availability: In development of models, generally need long time frame of data for good model - do we have
that data/time.

« Who will the users of the system be?

* How to integrate fish and fish habitat into the modelling system

* How simple/complex will model be? (keep it manageable/user-friendly; be realistic)

» Bring existing knowledge to bear and newly collected to test

* Flexible - ability to examine a variety of options for differing objectives (i.e. timber mgmt, wildlife mgmt)

* Accounting for other changes in the environment (cumulative effects, hydro development, etc) - external influences
and unplanned events

= Scope of project: is this for MF or larger land base (i.e. portability to other areas or specific to WNMFEF?)

* Accuracy of databases being inputted into model (i.e. at what scale)

* Holistic or indicator species approach? How to proceed?

» Clear definition of assumptions and they need to be made explicit and tested

» Should set up a modelling sub-committee

* How to deal with heavy resource demands

2.2 Actions

This component of the workshop provided the participants with the opportunity to identify the factors within the
WMS that the users can manipulate. The models within the system will identify the perturbations throughout the
biological and managerial system being modelled.

* Identify/specify desired forest struclure; age class distribution (indicator); setting Annual Allowable Cut (AAC)
target
* Specify width of buffer/riparian zone



« Be able to input harvesting, fire, insect damage (not necessarily predicting these, but input area damaged); most
likely part of vegetation model

» Hunting, snaring - harvest of big game, etc.

* Harvesting - different methods (even aged, uneven aged, pattern); different levels (AAC target); within riparian
areas

» Weather (snow); short-term climate, i.e. several years

» The number, location, and type of stream crossings

» Access roads

» Silvicultural treatments (e.g. thinning, planting, vegetation control)

» Habitat enhancement (identify species' population-habitat interconnectivity)

* Human intervention (e.g. tourism)

* Slope and aspect

2.3 Indicators

The indicators are the predictions stemming from the operation of the WMS and the interactions defined within it.

Management decisions are aided through an examination of the information produced through WMS runs; the

predictions do not make the decisions (e.g. a prediction could be the population density of a species, the manager

would use this information to define hunting levels). The indicators identified in the workshop are as follows:

* productive capacity of habitat (incl. fish): numbers/km? numbers of individuals/biomass
- availability vs suitability; quality of habitat; spatial considerations must be considered and factored in;
for one or more species (marten, moose, raptors, bear, caribou, salmon, trout, songbirds, cavity nesters,
furbearers, hare, grouse, bats)

* Stream / water quality (sedimentation, quantity, efc)

* Biodiversity

* Wood volume (harvested)

* Age class distribution

* Population numbers/density - by species, age, etc (i.e. distinction between carrying capacity vs populations)

* Recreation

24 Space
The spatial (extent and resolution) aspect to be addressed with the WMS was reviewed.
* How large an area to be predicted at one time (extent); WNMF area 707,000 ha
* Resolution - if use stands then 40 000 forested stands in WNMF,; this creates problems with respect to spatial
considerations and hardware requirements
: vegetation dynamics on a stand level; stand aggregation based upon Forest Ecosystem Classification (FEC) may
be required io alleviate the potential resolution problem
: population (should/will) not be done on a stand level? watershed level? landscape?
* Aspatial modelling was not considered an option

2.5 Time

The temporal component of the WMS (i.e. how far into the future were predictions to occur) is another important
consideration in the overall system design.

* Time horizon (extent): 120-240 years

* Resolution: how often are predictions to be made (day by day or every 10 vears); for first 20 years (I year
increments); beyond 20 years (~5-10 year increments); annual with reports on 5 year increments

3.0 Other Issues

There were several issues which were raised throughout the bounding exercise which did not fit into one of the
bounding categories.



3.1 What is a modelling system?

Because of the diversity of interests and backgrounds represented in the modelling process, the need for the
establishment of a common language and common understanding of the concepts being discussed was clearly
identified.

A model is a conceptualization of how we see a piece of the natural resource system working (i.e. the relationship
between one species and its habitat). A modelling system consists of a variety of interlinked models (i.e. a number
of species and intervention effects on their populations and habitat).

An example of such a modelling system is the Hemlock Looper Decision Support System developed by the

Canadian Forest Service. Although not directly related to wildlife, the conceptual framework around which the
Looper DSS was constructed will be similar.

Larval Development
Model

General Quibreak
Risk Models

Qualitative

LOOPER
Timber Volume DSS
Decay Risk Model Defoliation
G

Tree Volume
Mortality Risk
Model

Conceptual Overview of
Hemlock Looper Decision
Support System

Figure 2: EXAMPLE OF & MODELLING SYSTEM

The linkage between each discrete piece in the wildlife modelling system (species model, harvest scheduler, etc)
provides an overview of the relationships between those pieces. The interconnectedness of the individual models
must be ensured in order to accurately define the larger picture of resource (value) management.

3.2 Users of the System

A brief discussion of who would be the users of the system occurred. The participants indicated that they wished
the system to be developed for use by managers, planners, and researchers. Irregardless of who uses the system,
at the end of the day, the users have to discuss their results in light of what is best for their respective authority in
addition to the other values represented around the table. A Decision Support System (DSS) is just a tool available
to managers to aid them in doing their job - managing the variety of forest values.

3.3 Hardware Requirements

The topic of hardware platforms from which the WMS would run surfaced periodically throughout the workshop.
The PC platform was identified as being preferred due to the availability of the PC; the workstation was identified
as being required for spatial modelling. Several options were identified and the relative merits of each discussed:
a PC-workstation link; PC only; workstation only. Due to the limited capabilities of the PC to handle large
quantities of spatial data, the PC only option was quickly dismissed. No decision was reached as to the platform(s)
to be utilized.



3.4 Model Linkages within WMS

An interaction matrix was constructed to identify which models can/will influence others within the Wildlife
Modelling System. The individual species' and vegetation models were condensed into a simple matrix consisting
of wildlife and vegetation. This was used to aid in the identification of the information flows from one model to
another model (e.g. vegetation to wildlife; wildlife to vegetation). Subgroups were formed to discuss the information
links both between and within the two identified components of wildlife and vegetation.

4.0 Vegetation Subgroup
4.1 Indicators (to be predicted by vegetation model)

In order to make an assessment of habitat quality for the wildlife species being modelled, the following indicators
were identified as having to be made by the vegetation model:

cubic metres harvested understory vegetation coarse woody debris
age class distribution ground cover vegetation snags - size/age
crown cover (%) overstory vegetation volume - basal area
height successional stage FEC

spatial arrangement of sites

4.2 Succession Model

The Canadian Forest Service and Memorial University of Newfoundland are currently collaborating to produce a
series of successional rules based on the Damman forest site types. The current weakness in this is the lack of
information regarding the temporal aspect of the transition from one site type to another; the vegetation change can
be predicted with a great deal of accuracy, but the time it takes for that change is still unknown. The Canadian
Forest Service is attempting 1o address this temporal unknown.

The focus with the current research has been on succession after intervention (i.e. harvesting). With some further
analysis, the data being collected can be utilized in determining, on a preliminary basis, the successionary patterns
for non-intervention scenarios. However, some additional research is required to identify the time lag between
successional transitions and to further refine the patterns of non-intervention succession.

4.3 Timber Supply Models

Currently, the two timber supply models being examined by the Data Standards and DSS Working Group of the
WNMEF are GISFORMAN+ and HSG, with GISFORMAN+ being recommended to the Management Group. These
are both spatial models which track forest development (mainly overstory and standing volume over time) on a stand
level resolution. Such a model can generate outputs related to growing stock (standing volume), volume harvested,
age class distribution, overstory vegetation (i.e. percent composition by tree species) every five years by stand. The
individual stands are tracked over time and aged through the use of successionary patterns generated by yield curves
(volumetric increment over time). The AAC is predicted using this information.

Although GISFORMAN-+ does predict stand development on a five year increment, at this time it only records the
first and last increments. Therefore, modification of the program would be required. Further modification would
also be required for the program to track height and crown cover development over time.

GISFORMAN+ has the potential to track habitat quantity for five independent wildlife species. An essential
component of such a process would be the quantitative definition of species' habitat in both structural and spatial
terms. These definitions would define habitat windows on the volumetric yield curves utilized by GISFORMAN+
allowing for tracking habitat supply through time. Although not directly linked with population objectives, this
approach allows for the achievement of habitat objectives for a species within timber management planning. To
date, this process has not been employed in Newfoundiand.

The understory (including ground cover and coarse woody debris) and snag components of forest structure are not
currently tracked by GISFORMAN-+. The Damman forest site types can identify the presence and absence of certain
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indicator ground species but cannot determine the volume of those species present on a site. A rough estimate of
the quantity of understory species could be made at this time using the FEC, however more research would be
required to refine these estimates. GISFORMAN+ could be modified to track the understory component in a similar
manner as that of the overstory (i.e. through yield curves). A second approach would be the development of a
parallel model which would track the forest site type for each stand.

Currently, the vegetative model component can, in addition to setting harvest and silviculture levels, set size and
adjacency guidelines for even-aged fibre management. Uneven-aged management regimes are difficult to spatially
model given the current structure of GISFORMAN+. The width of riparian zones would not be modelled; the
landbase boundaries would be modified before making a model run. GISFORMAN-+ does have the capability to
track successionary change within defined riparian zones. This permits examination of riparian zone (buffer)
management through intervention to perpetuate desired successional seres within zones or tracking of zone status
over time without intervention.

5.0 Wildlife Subgroup

The initial discussion held by the wildlife subgroup focused on the indicator species approach to wildlife
management within the WNMF and a review/update of the species being looked at. The consensus was toward the
creation of habitat suitability indices (HSI) for each species and a subsequent population interlink to this habitat
quantifier. This would be possible through a habitat-related carrying capacity linked with demographics. Further
discussion centred on the development of a generic population model to be interwoven with HSI models as an
alternative to the aforementioned population/habitat interlink process for the species under consideration.

The preliminary boreal owl work by Joe Brazil and Kathy Knox of the Newfoundland Wildlife Division was utilized
to exemplify a HSI approach for a given species within the WNMF. Through data collected in North America and
Europe on the boreal owl, parameters which could be used in describing the suitability of various stand types as
spring and summer habitat were identified with respect to the mensurational data contained on forest type maps.
These attributes were assigned a numeric value ranging from unacceptable to preferred. Through analysis of such
stand attributes by a scoring system and prorating, a HSI value was derived for each stand. Although this approach
allows only a "snapshot" of boreal owl habitat in successionary time, it does allow for the quantification of habitat.
The point was made regarding the need, and subsequent work being conducted, for refinement of the habitat
description for local (WNMF) conditions.

The need for a similar approach for the other wildlife projects within the WNMF was identified. The next step of
interlinking this HSI model approach to vegetative modelling to allow successionary rules to alter habitat over time
was discussed. A consensus was not reached regarding how this was to be done. The HSI models should allow
for the easy modification of the variables, formula and relationships as research results become available. This
modification potential of HSI models would allow for minimal "gaming" through adjustments and refinements in
the individual HSI within the overall modelling process.

The link between HSI and populations was recognized as being difficult but essential. A generic population model
component was deemed necessary even though such a model would be difficult and time consuming to construct.
Some demographic components of such a model would include predation, hunting, poaching, competition, cycles,
prey, and HSI for other species. Consequently, the model could estimate a HSI derived carrying capacity and use
the demographic information present or collected for the species to generate a population estimate through either
density or total numbers. Of high merit is the construction of population models to be interlinked with the habitat
quantification process for each species. This is being addressed for some species and was suggested to be examined
for all the WNMF indicator species. Again no consensus was achieved regarding how to proceed.

Aquatic models were briefly discussed regarding a HSI approach, population interlink, and effects of intervention

upon the aquatic system. It was agreed that the aquatic model component is to be "flagged" as part of the overall
wildlife modelling system but the specifics of how this is to be integrated was not discussed. Similarly, biodiversity
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and its respective measure was also discussed but again no consensus was reached on how to proceed.
6.0 User Interface

As is illustrated in Figure 3, the User Interface is one component of the overall Wildlife Modelling System.
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Figure 3: CONCEPTUAL QUERVIEW OF WILRLIFE MODELLING .

SYSTEM
Some of the key points raised during discussions were:

* Vegetation/harvest data not to be directly manipulated by wildlife researchers
* Gaming not necessary with vegetation/harvest models

« Library of runs from vegetation/harvest model

* Scenarios

*» Expert "in the loop" to develop libraries/scenarios

» Interface to allow access to wildlife parameters

* Vegetation/harvest model available via the expert "in the loop"

7.0 Qutput

This is an overview of the various types of output which the workshop participants indicated they would like to
see/need in order to make decisions.

» varying scales of maps (i.e. landscape to stand)



= various graphs (i.e. histograms, linear)
» tabular outputs (screen, printer, file)

8.0 Priorities

* FEC map completion (NFS,WNMF: George Kitchen, summer 1994)

* Historical Harvesting Database (WNMF, Derek Mercer, summer 1994)

* Developing attribule list for FEC map (non-timber attributes) (WNMF)
« developing relationships (currently rough estimates for some things available)
+ parameters to be collected not yet defined

* Identify HSI wish list and what information is needed to develop HSIs

» FEC successional model (CFS,MUN, summer 94)

= Decision on timber supply model to be used

* Accessibility attribute for stands

* Resolve spatial succession of stands using FEC info

* Decide upon aggregate spatial units for mapping output

« Classify fish habitat data

* Establish hardware connections (i.e. network, workstations)

« Identify project leader (wildlife coordinator)

* Initiate software development

» Identify how to proceed with WMS development

Where to from here?



